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1 INTRODUCTION 
 

1.1 Purpose 
 
The purpose of this document is to explain the features and operation of the Hydrotrac II. 

1.2 Scope 
 
The scope and content of this document is focused on providing useful information to the end-user. 
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1.3 Glossary 
 
DGPS  Differential Global Positioning System 
NMEA  National Marine Electronics Association 
VDC  Volts Direct Current 
TOH  Teledyne Odom Hydrographic 
PPS  Pulse Per Second 
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2 PRODUCT DESCRIPTION 

2.1 Hydrotrac II General Specifications 
 
Frequency Agile 
• Operator selectable through menu – 24, 28, 
33, 40, 100, 120, 200, 210 and 340 kHz 
Output Power 
• 600 watts 
Power Requirement 
• 11-28 V DC 
Resolution 
• 0.1 ft / 0.01m 
Accuracy 
• 200 kHz – 1cm (0.1% of depth value (corrected 
for sound velocity) 
• 33 kHz – 10cm 0.1% of depth value (corrected 
for sound velocity) 
Maximum Depth Range 
• 600m or 1800 ft. 
Environmental Operating Conditions 
• 0° - 50° C 
Communication 
• 2 RS232 ports or 1 RS232 and 1 RS422 
• Ethernet port 
• 8 bit data 
• 1600 samples/ping 
Printer 
• High resolution 8 dot/mm (203 dpi), 
16 gray shades 
• 216mm (8.5 in) wide thermal paper 
• External ON/OFF switch 
• Paper advance control 
Dimensions 
• 368 mm (14.5 in) H x 419 mm (16.5 in) 
W x 203 mm (8 in) D 

Weight 
• 22.5 lbs (10.2 kg) 
Display Panel Layout 
• 4 Line x 20 Character display 
• OFF/STBY/LOW/MED/HI Power Settings 
• Chart ON/OFF with LED inside 
• Chart Advance 
• Sensitivity 
• Chart Feed 
• Separate Panel Overlays for 
• Display and Chart controls 
• Keypad (arrow keys) 
• Power 
• Gain 
Sensor I/O 
• GPS 
• Annotates chart 
• Embeds position in Ethernet packet 
• PPS 
• Embeds UTC time in output string 
• MRU 
• Heave corrects data 
• Outputs MRU data in Ethernet packet 
• Remote Display 
• RS 422 interface 
Internal GPS with WAAS differential 
corrections and PPS reference signal 
• 16-Channel, L1(1575.42 MHz) GPS receiver 
• SBAS (WAAS and EGNOS) supported 
• Position Accuracy: 0.63 meters, CEP 50% 
(24hr static) 
• 1.31 meters, 95% (24hr static) 
• Typical dynamic accuracy 3-5 meters

• Time (PPS): +/_62ns synchronized to UTC time 
• Standard NMEA0183 output message 
Features 
• 8.5 in / 216mm thermal printer (fax paper) 
• Annotation printed on chart 
• LCD display (1 in. high) 
• Sealed keypad controls 
• Manual/remote mark command 
• Auto scale change (phasing) 
• Separate adjustment for power and 
pulse width 
• External GPS input 
• Heave input from motion sensor 
• Integrated OEM DGPS receiver 
• UTC time stamp capability 
• TVG curve for side scan and bathymetry 
• Output: NMEA, ECHOTRAC, DESO 25, etc. 
• Waterproof (with front cover in place) 
• Fix mark annotation: date, time, fix no., depth 
and GPS (if input) 
• Flash memory upgradeable 
• Waterproof DB9 connector serial ports 
(standard serial interface cables) 
• Built-in simulator 
• Serial port function test 
• Robust firmware upgrades by SD Card 
• E-chart Software included 
• Operation and installation manuals provided 
on CD 
Options 
• 200 kHz or 340 kHz side scan transducer 
• Remote display 

 

2.2 Scope of Material Included 
 

 Hydrotrac II Recorder 
 2 Serial cables 
 1 Crossover Ethernet cable 
 1 DC power cable 
 1 GPS antenna 
 2 rolls thermal paper 
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3 INSTALLATION 

3.1 Transducer Installation 
 
Proper mounting of the transducer is a crucial part of the installation of any "survey" echo sounder.  An improperly 
mounted transducer will result in poor system operation and unacceptable data quality.  
 

3.1.1 General Rules 
 
In the case of temporary installations, the transducer may be mounted over-the-side.  In permanent installations 
and “class 1 surveys", hull mounts are generally preferred and often required.  In either case, transducers should 
be mounted at least 0.3 meters below the waterline.  In cases where "over-the-side" mounts are exposed to wave 
action, ensure that the transducer is mounted sufficiently deep so that it does not break the surface during vessel 
roll motions. 
 
A preferred mounting location is near the keel of the vessel, in an area where the planning attitude of the hull at 
speed, and the pitch and roll angles of the vessel in seas, have the least effect.  The transducer should be 
mounted far enough aft of the bow so that bubbles generated by the bow wave will not pass over the face of the 
unit.  Transducers should be located away from sources of turbulence and cavitation bubbles such as propellers, 
bow thrusters and hull protrusions.  Considerations should also be given to sources of mechanical noise 
generated within the vessel (engines, props, pumps, generators, etc.).  In some severe cases of mechanically 
coupled noise, vibration-isolating mounts may be required to decouple the transducer from the hull. 
 
Transducer mounting can be accomplished in many different ways.  To follow is a list of common configurations: 

3.1.2 "THROUGH HULL" Installation 
 
The topside of the transducer is accessible from inside the vessel while the transducer face is directly exposed to 
the water.  Care should be taken to protect the transducer from damage and turbulence by installing a faring with 
a sloping forward edge ahead of the unit.  The faring has the dual effect of both minimizing possible strike 
damage and smoothing the flow of water over the face of the transducer. 

3.1.3 "SEA CHEST" Installation 
 
 In a "sea chest" mount, a fluid-filled enclosure, large enough to contain the entire transducer, is attached to the 
outer hull of the vessel.  The outer hull is removed within the area of the chest and replaced with an acoustically 
clear "window", which is mounted flush with the hull immediately below the chest.  Depending on construction, the 
material selected for the acoustic window, and the draft of the vessel, access can often be gained to the 
transducer from inside the hull without putting the vessel in dry-dock.  In most installations, a water-filled 
standpipe is incorporated into the "sea chest" design in order to provide hydrostatic pressure equalization.  
Transducer cables generally leave these assemblies through “stuffing tubes” that are designed to maintain the 
watertight integrity of the chest. 
 

3.1.4 Over The Side Transducer Installation 
 
A mount of this type is frequently constructed from a length of pipe.  This fixture should be sized to position the 
transducer well below the waterline and the pipe then fixed to a sturdy support on the vessel.  Lines generally are 
attached at the mounting pipe and tied off fore and aft in order to maintain a stable, horizontal head attitude.  Care 
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should be taken to assure adequate protection for the transducer cable, particularly at the point where the cable 
leaves the transducer body.  The position of the mounting assembly relative to other peripherals is critical for 
accurate data collection.    
 
Particular care should be taken to assure that the transducer radiating face remains as parallel to the water 
surface as much as possible while the vessel is moving. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.1.5 “HULL MOUNT” Installation 
 
Transducers which are “streamlined” and can be mounted directly to the outside of the hull or transducers which 
are fitted into a streamlined fairings that are welded or otherwise attached to the outside of the hull, often make for 
excellent installations.  The advantage here is that the radiating face of the transducer is generally below the 
“bubble stream” in clear water and no acoustic window or transducer tank is involved to create extra reverberation 
(ringing).  This type of installation requires a stuffing tube to be installed in the hull in order to allow the transducer 
cable to penetrate the hull. 
 
In all of the above installations particular care should be taken to assure that the transducers radiating 
face remains as nearly parallel to the water surface as possible while the vessel is underway. 
 

3.2 Hydrotrac II Cable Connections 

3.2.1 Serial 1 
 
Serial 1 is the main communication port to and from the Hydrotrac II.  Use this port to receive depth values, send 
annotation information and change parameters. 
 
Connector PN: Pin Number Signal Description 
DB9 Female 2 Transmitted data from Hydrotrac II 
 3 Received data to Hydrotrac II 
 5 GND 

3.2.2 Serial 2 
 
Serial 2 is used for connecting a remote display or motion sensor to the Echotrac MKIII.  Serial 2 is the only port 
that can be configured as either RS232 or RS422. 
 
Connector PN: Pin Number Signal Description 
DB9 Female 2 Transmitted data from Hydrotrac II 
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 3 Received data to Hydrotrac II 
 5 GND 
 

3.2.3 GPS I/O 
 
The Hydrotrac II has a built in GPS that main functions is to give the Hydrotrac II the UTC time which is used to 
time stamp the soundings.  The GPS I/O port also outputs the NMEA GGA string at 9,600 baud.  The internal 
GPS is not a survey grade GPS. 
 
Connector PN: Pin Number Signal Description 
DB9 Female 2 Transmitted data from Hydrotrac II 
 3 Received data to Hydrotrac II 
 5 GND 
Note: For external GPS use see Appendix C Internal Jumper Configuration. The use of an external GPS device 
may require a null modem adaptor.  Keep port and string configurations the same as the internal GPS settings. 

3.2.4 LAN 
 
The LAN connection is the Ethernet port for the Hydrotrac II.   
 
Connector PN: Pin Number Signal Description 
10BASE-T 1 TX + 
 2 TX - 
 3 RX + 
 6 RX - 

3.2.5 Transducer 
 
TX1 is the main transducer connection port for the Hydrotrac II 
 
Connector PN: Pin Number Signal Description 
MS3116J14-5P A Shield 
 B High Frequency 
 C Low Frequency 
 D Low Frequency 
 E High Frequency 

3.2.6 12-24 VDC 
 
The DC connector is used to supply DC input power.  The range of the DC power is 18-30 VDC. 
 
Connector PN: Pin Number Signal Description 
MS3116J12-3S A + 24 Volt DC 
 C GND 
 

3.2.7 FUSE 
 
This 5 Amp fuse protects against the Hydrotrac II drawing too much current from and external power supply.   
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3.3 Hydrotrac II Recorder Buttons and Knobs 

3.3.1 Power/Transmit Power Knob 
 
This knob controls the power to the Hydrotrac II and controls the transmit power to the Hydrotrac II transmitter.  
When the knob is turned from Off to Stby the LCD will prompt the operator to press a key.  Once the key has 
been pressed the chart will print a initialization message and the LCD will prompt the operator to select current 
setting, default settings or the maintenance menu.  Selecting the current menu will load the last used parameters 
into the Hydrotrac II.  Select the default setting to bring the Hydrotrac II to the original parameter settings.  This is 
equivalent to a reset. 

3.3.2 Sensitivity Knob 
 
This knob adjusts the amplification of the signal received from the transducer.  Increase the knob in areas with a 
softer seafloor or less reflectivity of the seafloor. 

3.3.3 Keypad 
 
The 10 raised micro-switches are part of the sealed display panel.  The keys have excellent tactile feel and high 
moisture resistance. The keypad is used by the operator for direct parameter entry and functional control of the 
unit from the front panel. There are four keys under the LCD that control the menus of the Hydrotrac II.  These 
menus are described in a later section of this manual. 

3.3.4 LCD 
 
The 4 line, by 20 character Transflective LCD Module with LED Back Lighting was chosen for it’s excellent 
visibility in all light conditions from bright sun to darkened wheel house. 

3.3.5 Printer On/Off button 
 
Turns the printer On or Off.  The LCD inside the button indicates whether the printer is on (LED ON) or off. 

3.3.6 Printer Take-Up button 
 
The Hydrotrac II printer has a slipping clutch that allows the operator to pull chart record that has been wound up.  
The Take-Up button allows the operator to take up the slack paper.  The take-up button is also useful when 
changing the paper. Note: the Take-Up and Feed buttons work independently to each stepper motor.  Pressing 
the feed button will not trigger the take-up motor.  

3.3.7 Printer Feed button 
 
This button can be used to feed blank paper through the print head.  This is useful should the operator wish to 
write information on the chart paper on a blank section of paper.  This button is also useful when changing paper. 

3.3.8 Printer Mark button 
 
When the Mark button pressed the Hydrotrac II printer will print a line across the chart along with date, time and 
depth along that line. 
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3.3.9 Printer Mechanism 
 
The high-resolution thin-film thermal print head (216mm (8.5”) wide, 8 dots per mm (203/in.)) is capable of printing 
up to 8 gray shades on high quality thermal film.  Due to its thin-film construction, it is very energy efficient and 
produces little excess heat.  The paper delivery and re-winding mechanisms contain few moving parts and are 
built to stand up to the rigors of marine use.   
 
 

3.4 Chart Paper 
 
General Paper Description: The Hydrotrac uses either thermal film or high quality thermal paper as the 
recording medium for the analog chart.  The rolls are 216mm (8.5”) wide and contain approximately 50m (170’) of 
paper or film.  The inside diameter of the core is 12.7mm (½”); the outside diameter of the roll is approximately 
64mm (2.5”). 
 
Paper loading is a multi-step process, but it need not be a difficult one if care is taken in assuring that each step is 
accomplished properly.  As in almost any thermal recorder (including FAX machines), paper is sourced from a 
supply roll, where it passes between alignment posts, and over a rubber roller fig 3.1, which moves the paper past 
the thermal printhead.  Attached to the printhead is a mechanical pressure lever, which when moved to the left, 
lifts the head away from the roller to assist in the initial loading.  In the Hydrotrac, printed chart paper is taken-up 
on an empty core installed at the far left of the chart panel. A precision stepper motor attached to the printhead 
assembly drive roller pulls paper off the supply roll and moves it past the printhead. The motor that drives the 
take-up spool does not advance the paper, as is the case in many echo sounders. Since paper drive and take-up 
are driven by separate mechanisms, previously printed chart can be pulled from the take-up assembly for review 
and simply re-wound without disturbing the recording process. 
 

 

                            Figure 3.1 Paper  

                     Supply & Take-Up Rolls 

 

                   

                                    Figure 3.2  

                                 Panel Release
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3.4.1 PAPER LOADING 
 
Step 1: In order to gain access to the paper supply and re-wind areas, open the chart panel by unscrewing the 
two black captive fasteners at the extreme left of the front panel (Figure 3.2).  Open the panel by pulling the 
handle at the left side of the front panel until the support arm engages a stop. 
Step 2: If paper has been previously installed in the unit, place the power switch in the STBY position and press 
the CHART FEED switch (upper right) until sufficient paper has been advanced to clear any previously recorded 
data.  Cut the paper at a convenient point past the recorded data and remove the old chart.  
Step 3: Swing the panels completely open to the last stop point on the support arm (Figure 3.3).  This will allow 
access to the paper supply and take-up assemblies located at the rear of the panel. 
Step 4: Locate the printhead release lever located below the printhead on the front side of the panel (Figure 3.4).  
Push the lever all the way to the left in order to raise the printhead away from the paper and roller. 
Step 5: Remove any remaining paper from the paper path and remove the spent supply roll from the holder 
mechanism.  Grasp the core and lift it upward and outward at the bottom.  The upward motion compresses the 
upper pressure spring and the outward motion clears the bottom of the core from the lower core-centering stud.  
Step 6: Use the same motion in order to remove the take-up roll from its holder mechanism. 
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3.4.2 Installing a fresh Paper Supply Roll 
 
Step 1: On the paper supply side (side closest to 
the printhead), raise the upper paper guide until 
the spring is fully compressed. 
Step 2:Insert the fresh roll of paper so that the 
core engages the top paper-centering stud and so 
that the paper comes off the roll at the rear  (as 
viewed from the front panel side of the unit) and 
the outside surface of the paper faces the 
printhead.   
Step 3: Align the roll so that it engages the lower 
centering stud, as it is set onto the lower paper 
guide. 
 
Feeding Paper past the Printhead 
 
Step 4: Feed paper off the supply roll from the 
rear and over the paper drive roller (between the 
printhead and the roller) with the outside surface 
of the roll toward the printhead.  Only the outside 
surface of the paper will produce an image.   
Note: the printhead release lever must be in the 
released position (far left position) in order to accomplish this task. 
Step 5: Once a small amount of paper is fed across the roller past the printhead, pull approximately 450mm (18”) 
through the printer.  This can be done easily if the paper is not allowed to engage the rubber paper drive roller 
with too much tension.  Feeding paper manually off the supply roll while pulling it past the printhead will assist in 
this task.  Once sufficient paper is fed past the print head, center the paper manually and return the printhead 
release lever to the engaged position (head locked down on the paper supply roller).   

3.4.3 Loading the Paper Take-Up Spool 
 
Step1: Guide the end of the paper through the 
paper entry slot and over the take-up roller bar.  Pull 
the excess paper through the slot. 
Step 2: Using a small piece of tape, attach the end 
of the paper to an empty paper core being sure to 
align the top and bottom edges of the paper with the 
ends of the core. Wind the extra paper up tightly 
onto the core.  Note: As shipped from the factory, 
paper is re-wound on the spent core in the same 
direction as it is fed off the paper supply roll.  This 
means that the printed image is wound on the 
outside surface of the recorded roll. 
Please note!  Best results are derived when a new 
core is installed on the Take-up spool with each new 
roll of paper.  Repeated use of the same Take-up 
core will result in the unit’s failing to re-wind paper 
reliably. 
 
 
 

 

                                    Figure 3.4  

                        Printhead Release Lever 

 

 
Figure 3.3 

Front Panel Extended 
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Step 3: Employing the same method used in loading the supply roll, install the core (with paper attached) in the 
Take-up Spool assembly.  
Step 4: Close the paper access panel by first releasing the support arm, closing the panel, and then re-tightening 
the two captive screws. Press the FEED switch (upper right) and observe that paper moves smoothly past the 
printhead across the paper access panel, and is wound onto the take-up core.  At this point the recorder should 
be ready for normal operation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PAPER TRANSPORT 
DIAGRAM

TOP VIEW 
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4 OPERATION 
 

4.1 Hydrotrac II Parameters 
 
In the Hydrotrac, parameters which control the way the echo sounder works—digitizing, printing, or 
communicating to the outside world, are manipulated using a system of menus and front panel mounted sealed 
keys. The display is a four line by twenty-character alpha numeric, transflective LCD module. The display is 
backlighted for nighttime viewing LED’s. The keys are made up of 10 embossed micro-switches 
molded into the display panel overlay. Each key is labeled with its function and provides positive tactile feedback 
upon actuation. The four keys located directly below the display provide immediate access to the four main 
menus for which they are labeled (DEPTH, SETUP, CHART, CAL.). The UP, DOWN, LEFT, and RIGHT arrow 
keys are used to navigate through the individual parameters and to change their associated values. The ENTER 
key is used to select a parameter who’s value is to be changed. Pressing the HELP key provides the operator 
with an immediate printed explanation of the purpose and use of the selected parameter. 
 

4.1.1 Changing Parameters 
 
The method used to change any parameter value is common to all parameters in the system. To follow is a 
description and typical example of the procedure: For instance, should we wish to change the internal time 
of day clock: First press the Setup Key, to access to the menu containing the Time parameter. Second, Select 
the Time parameter by moving the arrows (using the UP and Down arrow keys) to the Time line and then 
pressing Enter. Once the value for Time is selected (the blinking block cursor appears behind one of the 
digits), use the LEFT or RIGHT arrow keys to choose Hours, Minutes, or Seconds by moving the Cursor to 
the appropriate digit. Using the UP or DOWN arrow keys, slew in the new value. If necessary, move the 
cursor to the next digit (using the LEFT and RIGHT arrow keys again) and slew the correct digit into place. 
Once the displayed Time parameter is correct, press Enter again. This will cause the new value to become 
the current time. This method of entering data is common to all parameters. 

4.1.2 Depth 
 
Pressing the DEPTH key on the front panel results in immediate display of the digitized depth. The large 
characters incorporate segments from all four lines of the display. This is done in order to achieve the size 
needed for distant viewing. While DEPTH is the Menu most often displayed, it is not necessary to select the 
DEPTH menu in order for the unit to operate normally. The Hydrotrac II continues to sound, digitize and display 
the depth (in the upper right corner of the display) in all of the menus except Maintenance.  If the Depth button is 
pressed twice the Hydrotrac II will display the Latitude and Longitude of the GPS position along with the depth. 
 

4.1.3 Setup 
 
Pressing the SETUP key initiates the display of the basic parameters of the unit, which include the following: 
 

   Setup 10.01    
Blanking  0.0 
    Units Meters 
  Range        100 
     Serial1 Echotrac I/O 

Nmea DBS Out 
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DESO 25 I/O 
Heave Out 

  Serial2    OFF 
Heave IN 
Remote Disp 

  Time  15:32:15 
  Date 10/20/97 
  Serial1 Baud 19200, 9600, 4800 
  Serial2 Baud 19200, 9600, 4800 
  TVG Curve 10,20,40 Log 
  Frequency 24,28,33,38,40,100,

120,200,210,340 
Pulse Length Short, Medium,Long 

 
 

4.1.3.1 Blanking 
 
A Blanking feature is used to “mask” the transmit pulse, transducer ringing, or other unwanted acoustic returns in 
the upper water column (such as boat wakes), from the digitizer.  It is applied when these acoustic events could 
be mistaken for returns from the seabed or when the operator needs to force the sounder to “look” below an 
interference layer.  The value for Blanking is entered as a distance from the water surface and is indicated on the 
chart by a solid black line printed at the input depth. Blanking is one of the “Key Parameters” printed at sign-on 
and each time the parameter is changed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Figure 3.3 

 
Blanking Feature 

Blanking 
(set at 4.5 

)

Note: Alarm activated 
          when depth is  
          less than 
          “Blanking” 



Hydrotrac II 
User Manual 

Page 18 of 43 
    

  

4.1.3.2 Units 
 
Sets the operating units of the Hydrotrac II.  When units are set to meters the Hydrotrac will have centimeter 
resolution, when set to feet will have 0.1 foot resolution. 

4.1.3.3 Range 
 
As the name indicates, the Range parameter limits the maximum range of the digitizer.  For example, should a 
Range value of 100m be input as a value, then the unit’s digitizer will never look deeper than 100m for a valid 
bottom return.  This speeds up the digitizer since it no longer has to expand the tracking gate to include depths 
greater than 100m.  The feature is often used in conditions where the time needed to reacquire the bottom (after a 
loss of signal) must be minimized.  However, care should be taken not to set the Range at a value which is too 
shallow, since it will also inhibit tracking of valid returns deeper than the Range value as well. 

4.1.3.4 Serial1 
 
This is the primary serial port interface for the Hydrotrac II and should be used to receive depth information.  The 
Hydrotrac II outputs the following strings: 
 

 Echotrac I/O 
 Deso25 
 NMEA DBS 
 Heave 
 ET Mark1I/O 

 
When any of the first three formats are output and the Hydrotrac II is receiving data from a motion sensor, these 
strings will reflect a heave corrected depth.  When the Heave string is selected and the Hydrotrac II is receiving 
data from a motion sensor the depth and heave values will be uncorrected. Details of the formatting of each string 
can be found under a different section of this manual. 

4.1.3.5 Serial2 
 
This port is used by the Hydrotrac to receive data from a motion sensor or output data to a TOH remote display.  
When the TOH remote display is selected the Hydrotrac II serial port should be set to RS422. 

4.1.3.6 Time 
 
An internal real-time clock is used for time and date information even when power is removed from the unit. The 
correct time of day (or reference time) is entered via this parameter.  First Time is made the current selection by 
moving the brackets to the Time line and then pressing Enter.  Once the value for time is selected, use the LEFT 
or RIGHT arrow keys to chose the appropriate Hour, Minute, or Second digit.  The selected digit will be noted by 
the presence of the blinking Block Cursor. Use the UP or DOWN arrow keys to slew to a new value.  Pressing 
Enter again will cause the new value to become the current time. 

4.1.3.7 Date 
 
The current Date is entered in much the same manner as Time.  Begin by selecting the proper line and then 
choose the digit to be changed. Use the UP or DOWN arrow keys to slew to a new value.  Pressing Enter again 
will cause the new value to become the current Date. 
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4.1.3.8 Serial1 Baud, Serial2 Baud 
 
Set the baud rate for com 1 and com 2 from 4800 baud to 19,200 baud.   

4.1.3.9 TVG Curve 
 
Multiple TVG curves are programmed into unit’s transceivers.  The 20Log Time Varied Gain curve is the generally 
accepted standard in single beam vertical echo sounders and the default value for the Hydrotrac II.  The 20Log 
curve includes compensation for both spherical spreading loss and absorption losses.  The 40Log curve is the 
standard for use with the Side Scan option.  The 10Log scale is intended for use in shallow water.  
 

4.1.3.10 Frequency 
 
Sets the operating frequency of the Hydrotrac II.  This setting should match the frequency used with the Hydrotrac 
II.  The available frequencies are: 
 

 24 kHz 
 28 kHz 
 33 kHz 
 38 kHz 
 40 kHz 
 100 kHz 
 120 kHz 
 200 kHz 
 210 kHz 
 340 kHz 

 
When using 24kHz – 40kHz the low frequency pin connections should be used and when using 100 kHz and 
above the high frequency pin connections. 

4.1.3.11 Pulse Length 
 
Sets the pulse length of the transmit signal to the transmitter.  A rule of thumb is, in shallow water use as few 
cycles as you can get by with, while in deep water use as many as it takes!  Taken together with the Tx Power 
control setting, pulse width directly influences the total amount of acoustic energy generated.  
 
Frequency(kHz) Short Pulse Length(usec) Medium Length(usec) Large Length(usec) 

24 250 500 1000 
28 214 428 856 
33 189 364 727 
38 150 300 600 
40 150 300 600 
100 100 200 400 
120 80 160 320 
200 50 100 200 
210 94 188 376 
340 94 188 376 
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4.1.3.12 Alarm 
 
When the alarm is turned on and the echo sounder does not detect a valid bottom the Hydrotrac will turn on its 
sonic alarm. 
 

4.1.3.13 Minimum Depth 
 
The Hydrotrac will turn on the sonic alarm when the depth detected goes below the value entered for this 
parameter. 
 

4.1.4 Chart 
 

    Chart 10.1
Scale End 20
   Scale  Width 20
   Phasing Auto

 

4.1.4.1 Scale End 
 
The Scale End refers to the depth value at the center of the printed chart.  In the Manual Phasing mode, Scale 
End is used most often to move the beginning and ending scale values to two points which force the known depth 
to fall between them.  When the Phasing parameter is in AUTO mode, the Scale End value is recomputed each 
time the digitized depth approaches either scale limit. The Scale End can be incremented by any of the displayed 
whole digits (hundreds, tens, or units in meters). 

4.1.4.2 Scale Width 
 
Scale width printed on chart. Scale End value computes listening time and repetition rate. Values: 10,20,40,80 
meters;  30,60,120,240 feet. 

4.1.4.3 Chart Speed 
 
This parameter is used to control the chart speed of the thermal printer.  In SYNC mode the Hydrotrac will 
advance the paper chart once per sounding period.  On the other setting the Hydrotrac will advance the paper 
chart in centimetres per min. 

4.1.4.4 Phasing 
 
The Phasing control determines whether or not the sounder will be allowed to automatically recompute the Scale 
End value to avoid losing the bottom off the chart.  Two selections are possible; Auto and Manual.  In Manual, 
the Phase does not change as the depth changes.  It remains fixed at the Scale End value selected.  However, in 
Auto, as the bottom approaches the chart limits, a new Scale End is recomputed automatically and the Phase is 
adjusted so that the bottom is always plotted on the chart. 
 

4.1.4.5 Annotation 
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When the Mark button is pressed the Hydrotrac II will either print annotation information with the fix line on not 
depending on whether this parameter is turned ON or OFF. 
 

4.1.4.6 Print Parameters 
 
When the Enter button is pressed while the menu selection is on PrintParams the Hydrotrac will  printout all its 
parameter settings on the paper chart. 

4.1.5 Cal. 
 
Pressing the CAL. key initiates the display of the parameters required to accomplish a standard “Bar Check” 
calibration procedure.  Included are the following: 

  Calibrate 10.01 
  Bar Depth 10 
  Draft 1.6 
  Index .7 
  Velocity 1500 

 
Please note that the current depth is displayed in the upper right hand corner of all of the menus as long as the 
Hydrotrac is actively sounding.  In the Cal menu, it is provided in order to allow the operator to immediately see 
the effect of changing either Draft or Velocity.  It also makes it easy to confirm that the digitizer is locked either 
on the “Check Bar”, during the calibration process, or on the bottom when no value for Bar Depth is selected. The 
digitizer gate limits are also printed on the chart. 
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4.1.5.1 Bar Depth 
 
Entering a value other than “0” in the Bar Depth parameter puts the Hydrotrac in the “Bar Check Calibration 
Mode”.  If, for example, the operator enters a value of 5.00m as the Bar Depth parameter, then immediately upon 
pressing enter, the Digitizer will expect to see a target at that 5.00 meter depth (± 0.5m) while rejecting all other 
returns (including those from the bottom).  At the same time, the printer will begin to print the tracking gate at a 
total width of 1.00m centered about the Bar Depth. 

4.1.5.2 Draft & Index 
 
Draft is the correction value added to the measured depth to adjust for the difference between the depth of the 
transducer and the water’s surface (a + dr – k) where: “a” is the measured depth and “dr” equals the draft (depth 

of the transducer below the water surface).  Index constant “k” is system delays originating in both transducer and 
echo sounder circuitry.  In the accompanying illustration, “d” is equal to the depth of the seabed below the water’s 
surface.   
 
Note: Many users may not be familiar with the parameter “Index” or “k”, although it is likely that they have seen 
the results of combining transducer draft and index constant into one draft figure.  If you have noticed that the 
measured draft, or the distance from the face of the transducer to the water’s surface is not the same as the draft 
value entered into the sounder, then you have seen the result of lumping both together.  This phenomenon is 
most evident when using dual frequency transducers where both high and low elements are in the same housing.  
Often, the draft values are very different for the two frequencies if no adjustable “k” parameter is incorporated.  
The difference in “k” or electronic delay between a 200 kHz element and a 24 kHz array is substantial, and is the 
reason behind the difference between the two “Calculated Drafts”. 
 
Once the “k” value is determined, it will not change until either the sounder or the transducer is changed.  The 
Index parameter should be adjusted to make the measured draft and the calculated draft equal. Depth is 
computed according to the General Formula shown below: 
 

d = ½ (v * t) - k + dr 

 

Figure 3.5  Bar Check Calibration
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d = depth from water’s surface  
v = average speed of sound in the water column 
t = measured elapsed time of signal travel from transducer to seabed and back to the transducer 
k = system index constant 
dr= difference from referenced water surface to transducer (draft) 

 

4.1.5.3 Velocity 
 
This parameter allows the operator to change the speed of sound variable in the depth equation.  Having the 
ability to change the speed of sound increases the accuracy of the system by allowing the sounder to adapt to 
changing local conditions that affect the propagation speed of sound in the water.  Whether derived as a result of 
the “Bar Check” method of calibration, or taken directly from a velocimeter, Velocity is critical to measurement 
accuracy. 
 

4.1.5.4 Simulator 
 
The simulator is a way of testing the Hydrotrac’s interface with the data acquisition computer and also a way for 
the surveyor to familiarize themselves with the parameter of the Hydrotrac.  To use the Simulator, turn this 
parameter on and then use the sensitivity knob to adjust the depth.  Make sure to turn the simulator off before 
starting a survey. 

4.1.6 Start up Menu 
 
When the Hydrotrac II is first powered up the following start up screen shows up in the LCD: 
 

System Startup 
  Use current setup 
  Use default setup 
  Maintenance  

 
This menu allows the operator to choose which parameters are loaded into the Hydrotrac or enter the 
maintenance menu. 
 
The startup menu is also available when the Hydrotrac II power knob is set to Standby and the operator presses 
the left arrow key. 

4.1.6.1 Use current setup 
 
When current setup is selected the Hydrotrac II will load the last values used by the operator for all the 
parameters. 

4.1.6.2 Use default setup 
 
When default setup is used the Hydrotrac II will load the default parameter list.  This is useful to load a know set 
of parameters if the Hydrotrac II is performing unpredictably. 

4.1.6.3 Maintenance Menu 
 
The maintenance menu is used to test the serial ports of print a grey shade test of the printer.  When Serial 1 or 
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Serial 2 is selected the Hydrotrac II will output either the string “Serial 1” or “Serial 2” through the corresponding 
port.  If pins 2 and 3 of either serial port are shorted together the “Serial 1” or “Serial 2” string will display on the 
LCD.  When the Chart test is selected the Hydrotrac II will print a chart test pattern of grey shades.  Make sure the 
Printer ON/OFF button is turned on to use this test. 
 
To exit the Maintenance menu and return to configuration menu press the left arrow key. 

4.2 Interfacing 
 

4.2.1 Serial Output Strings – Serial1 

4.2.1.1 Echotrac I/O 
 
ECHOTRAC I/O is the standard serial output string first introduced in the Echotrac DF 3200 MKI in 1985.  Due to 
the wide acceptance of this string and the availability of the format in a number of data acquisition systems, the 
string has been maintained in order to assure continued compatibility.  
Please note that characters 2 & 3 are lower case whenever the Units parameter selected is Meters (centimeter 
resolution).  The foot serial output string varies from the metric string in that characters 2 & 3 are always upper 
case (tenths of feet). 
 
 

Char. # Description 
1 Normally Space “F” Indicates 

Fix Mark 
2 “E” foot units, tenths res. 

“e” metric units cm. Resolution  
3 “T” foot units, tenths res. 

“t” metric units cm. Resolution  
4 Normally a Space “E” indicates 

Error 
5 Always a space 
6 Depth Data (MSD) 
7 Depth Data 
8 Depth Data 
9 Depth Data 
10 Depth Data (LSD) 
11 Carriage Return 
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4.2.1.2 Heave 
 
Note that upon selection of Heave IN on Comm 2, and Echotrac I/O on Com 1, the depth output from Comm 1 is 
automatically corrected for the received Heave value.   
Selection of Heave Out on Comm 1 (see Section 3-18) results in an output string containing the raw (uncorrected 
depth) and the most appropriate heave value.  Note this string is identical to the Echotrac DBT string with one 
channel selected and Heave enabled. 
 

Char. # Description 
1 Normally Space “F” indicates Fix Mark 
2 “E” decimeter resolution “e” centimeter  
3 “T” decimeter resolution “t” centimeter 
4 Normally Space, “E” Indicates Error 
5 Frequency Indicator Fixed “H” 
6 Always Space 
7 - 11 Depth data 
12 “+ or –“ 
13-16 Heave Data 
17 Carriage Return 

 

4.2.1.3 DESO 25 
 
The following description applies when DESO25 I/O is selected as the preferred output string under Comm 1.  
 

Char. # Description 
1 Always “D” 
2 Always “A” Channel 1 
3 Depth Data (MSD) 
4 Depth Data 
5 Depth Data 
6 Depth Data 
7 Depth Data 
8 Decimal Place (.) 
9 Depth Data 
10 Depth Data (LSD) 
11 Space meters    “F” Feet units 
12 “m” meters       “t” feet units 
13 Carriage Return 
14 Line Feed 
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4.2.1.4 NMEA String (DBS) 
 
Included in the choices of serial output formats, is the DBS string.  This string is included in order to provide a 
standard global format.  It is widely accepted and therefore more easily interfaced to software suites written for 
applications outside of the Hydrographic community.  
 
The NMEA String as transmitted by the Hydrotrac has the following parameters: 
Baud Rate:  9600 
Stop Bit: 1 
Parity:  None 
Data Bits: 8 
Terminator: Cr/Lf 
 
 

Char. # Description 
1 Always a “$” Sign 
2-6 Always SDDBS  
7 Always a comma “,” 
Next Field Depth in feet (may be no 

chars) 
Next Char Always a comma 
Next Char “f” for feet (may be no chars)  
Next Char Always a comma 
Next Field Depth in Meters (may be no 

chars) 
Next Char Always a comma 
Next Char “M” for meters (may be no 

chars) 
Next Char Always a comma 
Next Field Depth in fathoms (may be no 

chars) 
Next Char Always a comma 
Next Char “F” for fathoms (may be no 

chars) 
Next Char “*hh”  numeric checksum char 
 <CR><LF> 

 

4.2.1.5 ET Mark1 I/O 
 
This output format is exactly like the Echotrac I/O format.  The only difference between the ET Mark1 I/O format 
and the Echotrac I/O selection is in how the annotation control is processed.  When ET Mark1 I/O is selected the 
Hydrotrac II will send a Hex 02 after it has received the Hex 1 indicating it is ready to receive the annotation 
characters.  The Hydrotrac II will also reply with a Hex 02 when it has received a “CR”.   

4.2.2 Serial Data Input and Annotation 
 



Hydrotrac II 
User Manual 

Page 27 of 43 
    

  

Information, which in the past had to be handwritten on the chart record, can now be transmitted to the Echotrac 
via the RS232 input line.  Up to 80 ASCII characters per line can be printed on the chart. 

4.2.2.1 Event Line (Fix Mark) 
 
A single line across the chart is produced by sending a HEX 06 (ASCII “ACK” or “Control F”).  An event line will be 
printed across the chart at the end of the current sounding cycle.  Event lines do not delay or interfere with normal 
operation of the unit. 
 
 

Event Annotation 
 
When required, the event line can be annotated with up to 80 characters of information.  This is achieved by 
following the HEX 06 (Fix Mark) with HEX 01 (ASCII “SOH” or “Control A”).  As in the earlier models of the 
Echotrac, the sounder will respond to the “Control A” with a HEX 02 (ASCII “STX” or “Control B”).  However, it is 
no longer necessary to wait for the “Control B” before sending annotation data. Data may be sent to the 
Echotrac immediately after transmission of the “Control A”.  The “Control B” was retained in order to remain 
“downwardly compatible”. 

4.2.3 Ethernet Output 
 
The Hydrotrac II has an Ethernet port that outputs the time series of the acoustic data sampled by the analog to 
digital converter.  Each packet from the Hydrotrac II contains 1600 samples if set to meters or 1590 samples if set 
to feet of 8 bit data. The data output from the Hydrotrac II is UDP and is output on UDP port 1600. 
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5 CALIBRATION 
 
 
The principle of echo sounding is based on measuring the time of arrival of an acoustic return (echo) referenced 
to the time of transmission.  The time required for sound to travel from a source (the transducer) to the seafloor or 
bottom, and back can be measured and multiplied by the velocity of sound in water in order to arrive at the 
distance the pulse has traveled.  Since the transmitted pulse has traveled from the transducer to the bottom and 
back again, then the distance must be halved in order to obtain the water depth.  As shown in the general depth 
formula below, other factors enter into the equation as well. 
 
   d =  v  x  t   -k +dr 

              2 

 
Where:  
d - Depth from referenced water surface. 
v - Average velocity of sound in the water column. 
t - Measured elapsed time from the transducer to the bottom and back to the transducer. 
k - System index constant. 
dr - Distance from reference water surface to the transducer (draft) 

 
Since depth measurement accuracy is dependent on the value used for the velocity of sound in water (along with 
the other factors shown above) it is important that a realistic value for sound velocity be determined.  In water, 
velocity is a function of temperature, salinity and pressure.  Understandably then, the local sound velocity may 
vary widely, thereby resulting in the need to calibrate any type of echo sounder, in order to provide the most 
accurate depth data at a given location. 
 
The most common calibration technique is the bar check method.  This method, when employed properly, has the 
advantage of correcting for velocity variations, draft variations, and system index errors (all of the constants in the 
above formula).    When calibrating using the bar check method, acoustic returns are generated by a suspended 
target  which is lowered to a known depth between the transducer and the bottom.  In this circumstance it 
becomes desirable to have a method whereby the digitizer will see only the Bar (the target) and be prevented 
from locking on to actual bottom returns.  Since the Hydrotrac employs a dynamic tracking gate or window 
through which the digitizer looks for echoes from the seabed, manual control of the position and width of the gate 
is necessary in order to force it to remain fixed around the Bar.  This is achieved by using the Bar Depth function. 

5.1 BAR CHECK CALIBRATION 
 
As indicated in paragraphs 3-23 through 3-24, the Calibrate Menu brings all of the parameters necessary to 
calibrate the sounder together in one display group.  By pressing the Cal key, the operator is presented with the 
following menu: 

    Calibrate 10.01    
Bar Depth 10 
    Draft 1.6 
 Index .7 
   Velocity 1500 

 
NOTE: HEAVE IN must be OFF and the unit’s power and sensitivity adjusted to levels which provide reliable 
depth information from the project depth and bottom material. 
 
 
 



Hydrotrac II 
User Manual 

Page 29 of 43 
    

  

1. With Bar Depth parameter bracketed, press the Enter key.  Enter the first calibration depth.  That is, the 
measured depth of the “Check Bar” at its shallowest calibration depth. 

 
2. Deploy the Check Bar below the transducer to the first calibration depth (for example 2 meters or 10 ft.).  

Confirm that a return is printed on the chart between the two Bar Depth lines, and that the digitizer is locked to 
the Bar.  
Select the Draft parameter (bracket it and press ENTER).  Slew the Draft value to the depth of the transducer 
from the water surface.  

 
3. Slew the Index value until the Calibrate Depth equals the depth of the Check Bar (determined from the 

suspension chain).   
 
4. Lower the Check Bar to the deepest calibration depth, for example 15 meters (40 ft.) and adjust the Bar Depth 

value to equal the depth of the Check Bar. 
 
5. Select Velocity.  Slew the Velocity up or down to the point at which the Calibrate Depth equals the measured 

depth of the Check Bar. 
 
6. Repeat Steps 4 to 5 until the Calibrate Depth equal the Check Bar depth at the shallow and deep checks. 

 
7. IMPORTANT!  Adjust Index only when the BAR is at the shallowest depth (where velocity has minimum 

effect) and VELOCITY only when the BAR is lowered to greater depths (where velocity becomes 
predominant). 
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Appendix A. POWER Cable Conn. (DC only) 
P/N:  MS3114E12-3P   
Pin #   Description 
A  --------------------  +12 or 24 VDC 
B  -------------------- No Connection 
C  -------------------- Return 
 

 
 
 

B 

C A 

Power Connector 
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Appendix B. Motion Reference Unit output string 
 
The Hydrotrac II will only read the TSS1 output string.  The format of the string is: 
 
The TSS1 data string contains 27 characters in five data fields. 
 
The acceleration fields contain ASCII-coded hexadecimal values. Horizontal acceleration 
uses units of 3.83cm/s² in the range zero to 9.81m/s². Vertical acceleration uses units of 
0.0625cm/s² in the range –20.48 to +20.48m/s². 
 
The motion measurements contained in the data string will be in real time, valid for the 
instant when the system begins to transmit the string. 
 
Motion measurements include ASCII-coded decimal values. 
 
Heave measurements are in cm in the range –99.99 to +99.99 meters. Positive heave is 
above datum. 
 
Roll and pitch measurements are in degrees in the range –90.99° to +90.99°. Positive roll 
is port-side up, starboard down. Positive pitch is bow up, stern down. 
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Appendix C. Internal Jumper configurations 
 
The communication board inside the Hydrotrac II has a number of jumper settings that can be moved to change 
the configuration of Com2 from RS232 to RS422 and whether the Hydrotrac II uses the internal GPS or gets data 
from an external GPS.  To change these jumpers remove the four nuts securing the cover over the internal circuit 
boards.  The communication board is the one labeled 2420-0005-REV#. 
 
 
Jumper 
Name 

Default Jumper setting Optional Jumper setting 

JP1 1-2 (Serial2 set for RS232) 2-3 (Serial2 set for RS422) 
JP2 1-2 (Serial2 set for RS232) 2-3 (Serial2 set for RS422) 
JP3 Open none 
JP4 2-3 (Serial2 set for RS232) 1-2 (Serial2 set for RS422) 
JP5 1-2 (422 120 ohm termination)  
JP6 2-3 (Serial2 set for RS232) 1-2 (Serial2 set for RS422) 
JP7 Short (Active GPS antenna) none 
JP8 1-2 (Internal GPS PPS into Hydrotrac II) 2-3 (External GPS PPS into Hydrotrac II) 
JP9 1-2 (Internal GPS data into Hydrotrac II)  (External GPS data into Hydrotrac II, see JP10) 

JP10 1-2 (Internal GPS data into Hydrotrac II) JP9 pin 2 – JP10 pin 3 (jumper wire included) 
JP11 2-3 (Internal GPS to output through GPS I/O port) 1-2 (External GPS to input through GPS I/O port) 
JP12 2-3 (Internal GPS to output through GPS I/O port) 1-2 (External GPS to input through GPS I/O port) 
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Appendix D. Upgrading Hydrotrac II FPGA and Firmware 
 
The Hydrotrac II is upgradable through a SD card which is located inside the Hydrotrac II next to the connector 
side of the case.  Remove the thumb screw securing the red cover over the SD card socket.  There should be a 
blank SD card in the socket.  TOH will send a file with a _sw.flash and _hw.flash extention.  Copy the upgraded 
files received to the SD card.  A SD card adaptor might be necessary to transfer the files from the computer to the 
SD card.  Most laptop computers will have a SD card slot to plug the card.   
 
Plug the SD card into the Hydrotrac SD card slot and power up the Hydrotrac II.  The LCD screen on the 
Hydrotrac will stay blank until the upgrade is complete.  The upgrade might take up to 30 seconds depending on 
how much is being upgraded.  Once the upgrade is complete the Hydrotrac II LCD menu will start up normally.   
 
To complete the upgrade, delete the files on the SD card and replace the empty card in the socket.  Make sure to 
put back the cover on the socket.  Leaving a SD card with the upgraded firmware in the Hydrotrac II to delay 
starting up as it will always load the firmware from the SD card socket. 
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Appendix E. Hypack Ethernet Interfacing with the Hydrotrac II 
 

INTRODUCTION 
 
The Hydrotrac II has an Ethernet port that outputs the digitized samples to 8 bits of the acoustic signal from the 
unit's receivers. This data has normally always been printed on the chart and only the digitized values have been 
input into the hydrographic software that is logging and editing the data. To fully leverage the power of having all 
this acoustic data available Teledyne Odom Hydrographic and Hypack have developed an Ethernet driver that will 
read in the acoustic data into Hypack as well as the digitized values. All the normal fix marks are still printed on 
the chart. The real power of having the data available in Hypack comes into play when the surveyor goes to 
review and edit the data. Instead of only having a digitized line on the screen and then having to refer back to the 
chart for reference, all the acoustic data is in the background. The surveyor can now edit the digitized data with 
much more precision and confidence. The raw acoustic data is never altered during the editing process. 
 
If the Hydrotrac II is going to be connected directly to the computer then a cross over Ethernet cable is required. 
This is the red Ethernet cable supplied with the Hydrotrac II. If there is a network hub between the computer and 
the Hydrotrac II then a straight network cable is required from the Hydrotrac II and the network hub. 
 

SETTING UP THE HYPACK DRIVER FOR NORMAL SURVEYING 
1 - In the Hypack Max menu select Preparation->Hardware->Hypack Hardware. 
2- In the Edit menu select Insert->Device. 
3- Scroll down the list and select Odom CV3/MK3. 
4- Give the driver a name like Hydrotrac. 
5- Select Connect and then Network Port. 
6- Select UDP for Protocol, Client for Role and under Port put 1600. For Write Port put 1601. 
This is what the Hypack Hardware setup should look like at this point 
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Next click on the Setup… button but make sure the Hydrotrac device is highlighted under the Hypack 
Configuration menu. Make sure Channel 1 under the setup menu is set to Bathy and all other channels are turned 
Off. 
 

 
 
 
 
 
Testing driver: After starting the Hydrotrac II highlight the Hydrotrac device in the Hypack Hardware setup and 
right click with the mouse, select test. 
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Initially when starting the test only the window labeled Hydrotrac will open up. Click on the 1 button to display 
the signal from channel. Click anywhere on the Odom Sonar Channel 1 window and select beam to display the 
actual signal. Once the data is verified close the window and start Hypack survey. 
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VIEWING THE RAW DATA IN THE SURVEY WINDOW 
 
Once the Survey program is started the operator can select the Hydrotrac window and view the data. Below is an 
example of what the data should look like. 
 

 
 
 
 

VIEWING AND EDITING THE ECHOTRAC DATA IN THE SINGLE BEAM 
EDITOR 
1- In the Hypack Max menu select Processing->Single Beam Editor. 
2- In the Single Beam Editor Max menu select Open and the log file name you created in the survey program. 
3- Once you have loaded the lines go to View->Other windows->Echogram in the Single Beam Max window. The 
echogram data should show up on the screen. 
4- You can select whether the data in the echogram window is the high frequency data, low frequency data or 
both combined. To do this select View->Options in the Single Beam Max menu. See picture below. 
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Editing the Data in the Echogram Window 
 
Below is a screen shot of some high frequency data in the Echogram window. If you look closely there is a black 
line on top of the red trace. This is the digitized value from the Hydrotrac. You can move the mouse and click 
along the record to show exactly where the digitized values are. You can click on the zoom button and then 
select the area you want to view better. 
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This screen is a zoomed in portion of the above screen. You will notice there appears to be an object on the 
bottom that we will edit out of the final data. 
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To edit the data click on the Digitize button and then click with the mouse along where you want the digitizer to 
go. Black dots will appear along where you clicked with the mouse. When you have finished editing and you meet 
the original digitized line release the digitize button. The digitizer line will merge with the original line. See the 
screens below. 
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Line re-digitized 
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Appendix F. Firmware Revisions 
 

FGPA firmware 
Version Description 

0.05  Added heave correction to Serial 2 input 
 Added remote display output to Serial 2 input 
 Added data and time to annotation information 
 Enabled chart test on maintenance menu 
 Enabled Serial 1 and Serial 2 to maintenance menu 
 Printer Help menu implemented 
 Bar depth width adjusted from 2m to 1m and 6ft to 3ft 
 Changed Com1 and Com1 menu to Serial1 and Serial2 
 Remapping of printer intensity 
 Internal GPS configured to NMEA GGA 9600 baud 

0.06  Fixed bug that was causing menu to lock up 
 Added Annotation string ON/OFF parameter 

o When Annotation is on and Mark button pressed fix line and annotation is printed 
o When Annotation is off and Mark button is pressed only fix line is printed 

 Added leading 0 to Blanking, Draft and Index Parameters 
0.07  Serial1 and Serial2 port test now outputs data through the port and displays received data 

on the LCD screen 
 Fixed fix mark command through the serial port to print fix line 
 Added display of GPS Lat and Long to the display when depth key is pressed twice 
 Added GPS Lat and Long to the annotation string when mark is pressed and annotation is 

enabled. 
 Fixed bug that was causing stored parameters to get reset to default under certain 

conditions. 
 Reduced minimum gate size to 0.5 meter and 2 ft. 

0.08  Added Minimum depth alarm 
 Added Manual Chart Speed 
 Added Print Parameters 
 Added printout of key parameters when they change 
 Added Sonic Alarm 
 Changed Parameter storage from Flash to battery backup on RTC 
 Added more help context in printouts 
 Changed Ethernet packet size 
 Fixed bug where scale end could be set less than scale width 
 Changed auto scale adjustment so scale change happens before depth reaching end of 

scale value. 
 Fixed serial annotation so that it would work with GLDD driver 
 Fixed serial annotation so that it would recognize Carriage Returns that advance the chart. 
 Change print head burn mapping 
 Fixed serial annotation to buffer multiple lines of annotation 
 Added Simulator 

0.09  Fixed take-up button 
0.10  Fixed bug that would cause the bottom record not to print correctly at certain sound velocity 

settings. 
0.11  Added ET Mark1 I/O to the Serial 1 selections.  

 
Transceiver firmware 
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Version Description 
1  Initial version 
2  Changed IF to 100 Mhz 

 
Transceiver hardware 

Version Description 
1  Initial version 

 


